
PASSOS PARA A CRIAÇÃO DO PROJETO GRÁFICO E 
DIAGRAMAÇÃO DO MIOLO DE UM LIVRO COM O INDESIGN 
 
 
OBSERVAÇÕES INICIAIS 
 
Q Aqui não levamos em consideração os ajustes pelos quais os textos originais, entregues 
pelos autores às editoras, precisam passar, como preparação, normatização, revisão etc. 
Supomos, portanto, um texto final, pronto para ser diagramado e, assim, submetido a 
um projeto gráfico.  

 T
Q É bom lembrar antes a seqüência da disposição dos elementos constitutivos do livro, 
dividido em 4 partes: 

(Fonte: ARAÚJO, Emanuel. A construção do livro. São Paulo: Nova Fronteira, 1986) 
 
1. PRÉ-TEXTUAL 

 Folhas de guarda - folhas em branco que vêm após a capa e no final do livro. 
 Falsa folha de rosto (ante-rosto, frontispício ou falso rosto)  
o título figura em página ímpar, e a que se lhe opõe à esquerda deve ficar em branco. O título 
comparece sozinho, sem subtítulo ou quaisquer outros esclarecimentos, e é composto em corpo 
menor que o da folha de rosto. Deve ocupar o centro ótico da página 

 Folha de rosto (também chamada de frontispício) 
é onde se faz verdadeiramente a apresentação essencial do livro. No geral, apresenta o nome 
literário do autor, título e subtítulo, nome do tradutor, compilador, editor literário, diretor, 
organizador, prefaciador, ilustrador; número do volume; número da edição; imprenta 
(informações sobre o impressor ou editor comercial, cidade e ano da impressão). 
No verso: indicação de propriedade de direitos autorais ou editorais (o símbolo de copyright ©, 
acompanhado do ano e do nome do titular); se tradução, a identificação da obra original; se for 
o caso, relação de edições e tiragens; ficha catalográfica; nome da coleção. 

 Dedicatória 
quando existe, é normalmente consignada na página ímpar fronteira ao verso da folha de rosto. 
Nada se imprime no verso da folha. 

 Epígrafe 
quando existe, se define como uma citação, uma sentença ou um pensamento relacionado à 
matéria tratada no corpo do texto. Sob a epígrafe coloca-se ou a referência bibliográfica 
completa, ou só o autor e o título do trabalho de onde foi extraída, ou apenas o nome do autor. 

 Sumário 
 Lista de ilustrações 
 Lista de abreviaturas e siglas 
 Prefácio 
nota prévia, prólogo, advertência, preliminares, apresentação, preâmbulo, define-se como uma 
espécie de esclarecimento, justificação, comentário ou apresentação do texto. 

 Agradecimentos  
só se justificam em página própria (ímpar) se for volumosa a lista de pessoas e/ou instituições às 
quais o autor deva reconhecimento público para a realização do livro. Na maior parte dos casos 
essa lista cabe no prefácio. 

 Introdução 
não deve ser confundida com o prefácio. 
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2. TEXTUAL 
 
Ao contrário da parte pré-textual, aqui o diagramador estabelece um padrão único e regular a ser 
obedecido em toda a extensão daquilo que se denomina corpo principal do texto. Deve-se levar em 
consideração  

 as páginas onde se iniciam os capítulos  
São páginas capitulares. É preciso antecipadamente decidir se serão sempre em páginas ímpares, 
com diagramação no centro ótico, com capitulares;  

 os títulos dos capítulos; 
 as seções, subtítulos ou entretítulos 
Páginas subcapitulares; 

 a numeração ou fólio  
Não se coloca na parte pré-textual, entre o anterosto e o início do prefácio e nas páginas 
capitulares. É hábito, mas não regra, numerar-se as páginas do prefácio, dos agradecimentos e da 
introdução com fólios romanos, porém contados na seqüência que se inicia no ante-rosto; 

 Cabeças, cabeçalhos ou cabeços  
Aparecem no alto das páginas alinhados com a numeração, quando estes aí se registram. Sua 
função é marcar certas constâncias gerais (autor, título do livro) ou parciais (grandes ou 
pequenos seccionamentos) com vistas à orientação do leitor. A tradição tipográfica consagrou as 
seguintes parelhas: 

 
   - na página par o nome do autor, na ímpar o título do livro; 
   - na página par o título do livro, na ímpar o do capítulo;  
   - na página par o título do capítulo, na ímpar os subtítulos do capítulo. 
 

 notas  
Podem figurar na parte textual ou na pós-textual. Quando diagramadas no rodapé, são 
incorporadas à mancha gráfica do texto.  

 elementos de apoio  
Quadros ou tabelas, fórmulas matemáticas e químicas. 

 iconografia  
Imagens de natureza variada que acompanham o texto de livros, revistas, jornais, com o fim de 
orná-lo, complementá-lo ou elucidá-lo. 

 
 
3. PÓS-TEXTUAL 
 
Entre a parte textual e o fim do livro inclui-se a parte pós-textual, que pode ou não conter um ou 
mais dos elementos seguintes: 

 Posfácio  
Como elemento ocasional, ocorre ante a necessidade de acrescentar à última hora uma 
informação que, de algum modo, altere ou confirme o conteúdo da matéria tratada no corpo do 
texto. 

 Apêndice(s)  
Assim como os adendos, são, como matéria acrescentada ao texto, falsas notas, mas podem 
conter ainda elementos de ilustrações (mapas, tabelas e gráficos) 

 Glossário  
É uma coleção de glosas, uma lista de explicações de termos arcaicos, dialetais, técnicos. 

 Bibliografia   
Citação das fontes bibliográficas usadas pelo autor. 

 Índice   
 Colofão  
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É o último elemento impresso do miolo do livro. limita-se a referências objetivas sobre os 
responsáveis pela execução da obra (créditos) e sobre os dados técnicos do projeto gráfico. Os 
principais elementos constantes do colofão são os seguintes: Preparação do original: supervisão 
(ou coordenação) editorial, edição do texto, diagramação, arte-final, iconografia (ou seleção 
iconográfica), ilustrações (fotos, desenhos, gráficos, diagramas, incluindo os mapas), índice, 
capa. Realização gráfica: produção gráfica, tiopo e corpo/entrelinha, formato, composição 
(sistema e equipamento), revisão de provas, fotolitagem, impressor, impressão (sistema), papel, 
tintas, acabamento (ou encadernação) tiragem, tiragem especial, fim da execução (data). 

 Errata  
Lista de erros tipográficos encontrados no livro após a sua impressão, onde se assinalam as 
respectivas correções. 

 
 
4. ELEMENTOS EXTRATEXTUAIS 
 
Constituem o revestimento do livro:  

 Capa 
 Sobrecapa ou jaqueta  
Constituída por uma folha solta que envolve ou protege a capa. Em certos livros a sobrecapa não 
tem o mesmo formato da capa, tomando o aspecto de uma CINTA de altura equivalente a um 
quarto ou um terço da capa, onde se imprimem frases publicitárias. 

 Lombada ou lombo  
Onde se imprimem o título da obra, o nome do autor e, muitas vezes, o nome ou logotipo da 
editora, ou ainda o número do volume ou o ano da publicação. Recomenda-se que o título seja 
impresso de baixo para cima. 

 Orelhas 
 Contracapa ou 4ª capa 

 
 
 
PREPARAÇÃO DO TEXTO PARA DIAGRAMAÇÃO 
Preparar o texto (de preferência somente a parte textual), no Word ou outro editor de texto, para diagramá-lo 

com o software de paginação escolhido (Adobe InDesign, Adobe PageMaker, QuarkXPress etc.), de modo a 

excluir todos as linhas em branco entre os parágrafos. Para isso, no Word, é necessário ir a cada linha entre 

os parágrafos e deletá-las usando a tecla DEL. 

 1
Também devem ser apagadas todas formatações que fazem com que a distância entre os parágrafos, mesmo 

sem abertura de espaço com ENTER, seja maior do que a entrelinha do texto. Faz-se isso selecionando todo o 

texto (EDITAR > SELECIONAR TUDO) e, em seguida, aplicando os comandos FORMATAR > 

PARÁGRAFO. Na tela que aparece basta colocar ZERO nas opções ANTES e DEPOIS do item 

ESPAÇAMENTO. 

 

Não excluir do texto os trechos em negrito, itálico ou com outros recursos estilísticos que o 
autor tenha usado para destacar passagens de sua obra. Ao importar o texto para o 
programa de paginação, os destaques serão mantidos. 

 
 

Caso o texto a ser diagramado esteja em PDF, é necessário primeiro transformá-lo em 
DOC, RTF ou TXT com o Adobe Acrobat Professional (FILE > EXPORT). 
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OBSERVAÇÕES 
 
Q No ponto a seguir, é momento de criar o documento no InDesign onde o texto será 
d
li

iagramado. Mas é preciso que tenha sido decidido previamente o formato da página do 
vro, com suas respectivas margens Superior, Inferior, Externa e Interna, o que constituirá 

sua mancha gráfica. 

T 
 

 
 
 
Q A decisão sobre o formato do livro pode ser tomada levando em consideração a economia 
de custos com o papel. Sendo assim, deve ser pensado inicialmente um formato que tenha o 
melhor aproveitamento possível das folhas de papel disponíveis no mercado — BB (66 x 96 
cm), AA (76 x 112 cm), Americano (87 x 114 cm), Americanão (89 x 119 cm), Francês (76 
x 96 cm), além de outros não tão comuns. Estes são os formatos usados para impressão em 
gráficas tradicionais, normalmente usando o sistema de impressão offset (com fotolito e 
chapa de impressão). No caso de gráficas rápidas, os chamados birôs, é preciso se informar 
antes a respeito do maior formato de impressão delas, de modo a planejar o livro em função 
desta disponibilidade. 
Q Outro aspecto que pode decidir o formato do livro é também o tipo de conteúdo a ser 
diagramado e o público ao qual a obra se destina. Um livro de arte, com imagens, 
normalmente exige – além de um melhor tipo de papel e uma impressão colorida – um 
formato maior, de modo que as fotos sejam valorizadas, ganhando um espaço mais 
generoso. E com isso, o espaço em branco será também mais valorizado, assim como a 
mancha gráfica será menor, o que significará margens maiores.  
Q O mesmo não acontece com um livro de bolso, cujo objetivo principal é exatamente a 
economia de custos. Com isso, além de um papel mais barato e impressão PB, o formato 
será menor e, consequentemente, a mancha, maior, com margens menores. 
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Formatos mais comuns de 

publicações (cm) 
12 x 18 
14 x 21 
16 x 23 
17 x 24 
21 x 28 

 
Q FALAR SOBRE GRADE 

Q Decisões como estas já fazem parte do trabalho de concepção do projeto gráfico e que, no 
momento da diagramação, vão facilitar não só a distribuição do texto, mas também o uso de 
cabeço e de numeração (ou fólio). 
 
 
 

CRIAÇÃO DE DOCUMENTO NOVO 
Tendo previamente sido decidido o formato da página do livro, com suas respectivas margens Superior, 

Inferior, Externa e Interna, é hora de criar o documento no InDesign. 
 2

Abra o programa e use os seguintes comandos para abrir um arquivo novo: FILE > NEW > DOCUMENT 

(Arquivo > Novo > Documento) ou CTRL + N. 

 

Se o InDesign estiver sendo usado pela primeira vez depois de instalado, as medidas do 
documento estarão em Paicas. Para passá-las para centímetro, feche a caixa aberta e 
acione os comandos EDIT > PREFERENCES > UNITS & INCREMENTS (Editar > 
Preferências > Unidades & Incrementos). Na opção Ruler Units (Unidades da Régua), as 
opções Horizontal e Vertical devem ser mudadas para Centímetros. De agora em diante, 
todos os novos documentos serão criados com as medidas em cm. 
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Vamos aos itens que precisam ser respondidos na caixa para que o documento seja aberto: 

DOCUMENT PRESET (Documento Pré-configurado)  
; Opção para exibir o conjunto de pré-configurações de documentos salvos anteriormente 

através do botão SAVE PRESET (ver abaixo). Ao escolher uma dos itens apresentados na 

lista, o usuário depara-se com medidas, número de páginas, de colunas já previamente 

definidas. 

NUMBER OF PAGES (Número de Páginas)  
; Quando o usuário não souber de antemão o número de páginas que o documento final vai 

ter, como acontece no caso da diagramação de um livro, pode ser colocada apenas uma 

página. Quando o texto for importado, basta que a distribuição seja feita com a opção 

Automático ligado. Assim, o programa se encarregará de distribuir o texto pela página 1 e 

de criar as novas páginas necessárias ao restante do material. 

 

ADICIONAR NOVAS PÁGINAS NO FINAL DO DOCUMENTO — Depois que o documento 
é criado, é possível acrescentar novas páginas através do comando FILE > DOCUMENT 
SETUP (Arquivo > Configuração do Documento). Na caixa aberta surge o número de 
páginas já existente no documento. Se já existem 6 páginas e o usuário quer aumentar para 
20, é só digitar o número 20 em Number of Pages (Número de Páginas). A desvantagem 
deste recurso é que as 14 novas páginas são colocadas após a última página do 
documento. 

 
 
 

    ADICIONAR NOVAS PÁGINAS NO MEIO DO 
DOCUMENTO — Para inserir novas páginas no 
meio do documento, por exemplo, é necessário 
antes abrir a painel PAGES (WINDOW > 
PAGES). Com isso, o comando LAYOUT > 
PAGES > INSERT PAGES (Layout > Páginas > 
Inserir Páginas) passa apresentar as seguintes 
opções: Insert Pages (Inserir Páginas), Move 
Pages (Mover Páginas), Duplicate Spread 
(Duplicar duas páginas espelhadas) e Delete 
Pages (Apagar Páginas). Assim é possível definir 
a posição das páginas novas, além de 
estabelecer a qual página-mestra elas vão estar 
submetidas. 

 

 

 

 

 

 

FACING PAGES (Páginas Espelhadas)  
; Esta opção deve ser marcada quando o documento final for impresso em cadernos, como é 

o caso de jornais, revistas, livros etc., em que as páginas pares e ímpares ficam 

espelhadas. Se é o caso de um trabalho que vai ser encadernado, por exemplo, o uso da 

opção é facultativo, já que as páginas virão uma após a outra, como acontece com 

monografias. 
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MASTER TEXT FRAMES (Moldura de Texto na Página-Mestra)  
; Com esta opção marcada, a página-mestra terá uma moldura com a mesma medida da 

mancha gráfica, inclusive com divisão de colunas, se o usuário tiver escolhido esta opção. 

Com isso, cada página do documento já tem de antemão uma moldura, que pode ser 

selecionada usando-se as teclas CTRL+SHIFT sobre a página. Depois é só usar a 

ferramenta Texto para começar a escrever ou para importar um texto. Para importar o texto 

de um livro, não é necessário marcar esta opção. 

PAGE SIZE (Tamanho da Página)  
; A caixa Page Size já traz uma série de formatos previamente definidos (Letter, Legal, A4, A5 

etc.). Quando o usuário não encontra o formato desejado, pode então definir a largura 

(Width) e a altura (Height) diretamente nas caixas abaixo. Com isso, a opção Page Size 

muda automaticamente para Custom (Personalizado). Neste mesmo grupo de opções, o 

usuário pode ainda definir a orientação da folha: Portrait (Retrato) e Landscape (Paisagem). 

COLUMNS (Colunas) 
; Grupo para definir o número de colunas (Number) e a largura entre elas (Gutter) no 

documento. Caso o documento tenha apenas 1 coluna, não é preciso alterar o valor de 

Gutter (com padrão de 0,4233 mm). 

MARGINS (Margens)  
; Grupo para estabelecer as 4 margens do documento: Top (Topo), Bottom (Inferior), Inside 

(Interna) e Outside (Externa).. Caso o ícone Make all settings the same (Todas as 

configurações com o mesmo valor) esteja marcado, ao mudar qualquer uma das opções, as 

outras vão assumir o mesmo valor. Para valores diferentes nas quatro margens, é preciso 

desmarcar o cadeado (situação mais comum em caso de livros, revistas e jornais). 

ÁREA DE SANGRIA E ÁREA PARA INFORMAÇÕES SOBRE IMPRESSÃO (Bleed and Slug) 
; Esta opção somente torna-se visível se o 

botão MORE OPTIONS (Mais Opções) for 

acionado. Com BLEED é possível definir 

uma área de sangria no documento, de 

modo a ajudar na distribuição de 

elementos do layout que avançarão pelas margens do documento. Esta área pode ser de, 

no máximo, 0,5 cm. Para que os quatro lados do documento tenham a mesma área de 

sangria (o que acontece normalmente), basta marcar o ícone Make all settings the same 

(Todas as configurações com o mesmo valor). A área de sangria, quando o documento 

impresso passar pelo corte, será descartada. Ela é importante para evitar que os 

documentos com sangria tenham filetes brancos nas bordas do papel. 

; Com SLUG, pode-se determinar uma área além da sangria onde ficarão registradas marcas 

de impressão (marcas de corte, marcas de dobra, marcas de registro), tira de cor ou outras 

informações sobre o documento (nome do arquivo, por exemplo). Os quatro lados do 
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documento terão as mesmas medidas se o ícone Make all settings the same (Todas as 

configurações com o mesmo valor) estiver marcado. 

; O recurso é desativado quando se clica no botão FEWER OPTIONS (Menos Opções). 

SAVE PRESETS (Salvar Pré-Configurações)  
; Depois que o usuário define todas as características de um documento novo (largura, 

altura, margens, número de colunas etc.), pode salvá-las para usar em outras ocasiões. 

Basta, depois de configurado o documento, usar o botão e dar um nome às configurações. 

Com isso, quando precisar abrir um novo documento, a pré-configuração aparecerá na 

opção DOCUMENT PRESET (Documento Pré-Configurado).  

 

Configurações de documentos salvos previamente apresentam-se como um bom recurso 
para quem vai diagramar uma coleção de livros com o mesmo formato, margens, mancha 
gráfica, número de colunas etc. 

 

 

 
Documento novo criado, com páginas espelhadas, sendo exibidas margens, mancha gráfica 

(retângulos com linhas rosas), área de sangria (linhas vermelhas) e área para informações sobre 
impressão (linhas azuis) 

 

 

IMPORTAÇÃO DO TEXTO PARA O DOCUMENTO NOVO 
Ag

Ve
 3 ora que o documento novo foi criado, é hora de importar o arquivo de texto para distribuição pelas páginas. 

jamos os passos a seguir: 
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1. Certifique-se de que está na página 1 do documento e, de preferência, com a ferramenta 

Seleção  acionada 

 

 

Para navegar pelas páginas do documento, o InDesign oferece três possibilidades. A 
primeira é usando os comandos do menu LAYOUT: 
 - FIRST PAGE (Primeira Página) ou SHIFT+CTRL+Page Up. 
- PREVIOUS PAGE (Página Anterior) ou SHIFT+Page Up. 
- NEXT PAGE (Próxima Página) ou SHIFT+ Page Down. 
- LAST PAGE (Última Página) ou SHIFT+CTRL+Page Down. 
- GO TO PAGE (Vá para a Página) ou CTRL+J – Uma caixa é aberta para digitação do 

número da página desejada. 
- GO BACK (Voltar atrás) ou CTRL+Page Up. 
- GO FORWARD (Ir à frente) ou CTRL+Page Down. 
 
É possível ainda pular para uma 
nova página através da caixa que 
fica no rodapé da janela do 
documento. Com esta opção, é 
possível ainda mudar para as 
Páiginas-Mestra. 
 
E por fim, a mudança de uma 
página a outra pode ser feita 
através do painel PAGES (Window > Pages). Com o painel aberto, é preciso clicar duas 
vezes seguidas com o mouse sobre a página (ou página-mestra) desejada. 
 
 
 

 

2. Clique em FILE > PLACE (Arquivo > Importar) ou CRTL+D e localize o arquivo com o 

texto a ser diagramado. Ao ser aberto o arquivo, surge no documento um ícone que 

indica a presença do texto para distribuição pelas páginas. Coloque o ícone no 

início da mancha gráfica da página 1 e escolha uma das formas abaixo de pôr o texto:  

r criada.  

 

Vejamos as formas de distribuição de texto: 
MANUAL – O texto é distribuído por uma página ou coluna e para que continue sendo 
distribuído, a cada vez é preciso clicar no ícone vermelho que aparece na parte inferior 
direita dos quadros de texto. 
 
SEMI-AUTOMÁTICA (segurando a tecla ALT) – O texto flui pelas páginas ou colunas a 
cada vez, como no método manual, mas o ícone de fluxo de texto automaticamente aparece 
depois que cada página ou coluna é preenchida.  
 
AUTOMÁTICA (segurando a tecla SHIFT) – Adiciona, se necessário, novas páginas ou 
colunas até que todo o texto tenha sido distribuído no documento. 
 
DISTRIBUI TEXTO SEM ADICIONAR NOVAS PÁGINAS (segurando as teclas 
SHIFT+ALT) – O texto é distribuído pelas páginas existentes sem que novas sejam criadas 
ao fim do documento. O texto restante só será distribuído quando nova página fo
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CRIAÇÃO DO PROJETO TIPOGRÁFICO 

Co

fu

m todo o texto distribuído pelo documento, é o momento agora de estabelecer outros aspectos 

ndamentais do projeto gráfico (além de formato de página, margens e mancha gráfica). Para isso, é preciso 

levar em consideração os elementos que surgem na parte textual da obra: títulos, subtítulos, citações, notas 

de rodapé, numeração (ou fólio), cabeço (ou cabeçalho) etc. 

 4
Ao invés de estabelecer a formatação destes elementos em todo o texto, inicialmente pode-se fazê-la apenas 

em 1 ou 2 capítulos, a título de teste. Entretanto, é preciso, antes de tudo, checar para ver como o texto está 

organizado nas suas diferentes “camadas” e capítulos. É possível que o título da maioria dos capítulos 

tenhas entre 2 e 5 palavras, mas um dos capítulos tenha 20 palavras. Por outro lado, pode acontecer de um 

capítulo ser composto de texto corrido e outro ter numerosas citações e subtítulos. Escolhe-se, portanto, 2 

capítulos que apresentem estas discrepâncias, se for o caso. 

 

A única tarefa essencial do tipógrafo é interpretar e comunicar o texto. Seu tom, seu 
andamento, sua estrutura lógica determinam as possibilidades de sua forma 
tipográfica. 

(BRINGHURST, Robert. Elementos do estilo tipográfico. Versão 3.0. São 
Paulo: Cosac & Naify, 2005. p. 11) 

 

É então nestes capítulos que será aplicada a tipografia dos mais variados elementos do texto, assim como 

estabelecidos corpo, entrelinha, distância entre as palavras e letras, distância entre título e texto, de modo a 

diferenciar, criando uma hierarquia harmônica, os diferentes níveis do texto. 

 

Um romance muitas vezes parece ser um rio de palavras que flui continuamente do 
começo ao fim, numa série de cenas sem título. Pesquisas acadêmicas, livros 
didáticos, livros de receitas e outras obras de não-ficção raramente são homogêneos 
assim; muitas vezes, aparecem recobertos por títulos de capítulos, seções, subtítulos, 
blocos de citações, notas de rodapé, notas finais, listas e exemplos ilustrativos. Tais 
características podem permanecer obscuras no manuscrito, mesmo que estejam claras 
na mente do autor. Em respeito ao leitor, elas requerem identidade e forma 
tipográfica próprias. Cada uma das camadas e cada um dos níveis do texto devem ser 
consistentes, distintos, e ainda assim (em geral) harmônicos em sua forma.  

(BRINGHURST, Robert. Elementos do estilo tipográfico. Versão 3.0. São 
Paulo: Cosac & Naify, 2005. pp. 26-7) 

 
 

Outro aspecto importante a ajudar na definição do formato da página, da mancha gráfica, mas também da 

tipografia, ou seja, na criação do projeto gráfico, é que o designer saiba ao mesmo tempo o que  o autor 

está dizendo (o assunto do livro) e como  ele está dizendo, assim como o leitor a quem se dirige a obra. “É 

preciso saber de maneira genérica do que trata o livro e a quem dirigido. As convenções do design fazem um 

tipo de tipografia parecer normal para um grupo de leitores, mas extravagante para outro. Os livros dirigidos 

para os arquitetos normalmente têm um aspecto diferente daqueles feitos para os estudiosos da história 

européia do século XVII. (...)”, ensina Richard Hendel em O design do livro (São Paulo: Ateliê Editorial, 2003. 

p. 35). Isso não significa que o designer precisará necessariamente ler todo o livro. 
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A garantia de que o projeto tipográfico do livro, associado ao formato e mancha gráfica do 
documento, combinado com numeração de páginas e cabeço, está satisfatório em termos de 
legibilidade só será tida se o material for impresso. Ou seja, não é possível confiar no layout 
enquanto ele estiver apenas na tela do computador. É com a impressão que será atestada a 
necessidade (ou não) de ajustes como mudança da fonte, do corpo, entrelinha etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Página com o texto original, importado          Página com as primeiras mudanças 
    para o documento, sem  mudanças               tipográficas: fonte, corpo (11), 

       tipográficas              entrelinha (15), alinhamento (justif.) 
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Mais ajustes tipográficos, com formatação do número e do 

título do capítulo. Também aqui, por ser página de abertura 

de capítulo, o início do texto é distanciado do título de modo 

a deixá-lo no centro ótico da página. Nem todo design de 

livro, é claro, precisa ter o texto começando no centro ótico. 

 

É importante lembrar que todos os ajustes 

relacionados à entrelinha e, portanto, à distância 

entre os diferentes elementos da página, são feitos 

levando em consideração a grade da página, 

baseada, no nosso caso, na entrelinha 15 pontos 

tipográficos aplicada ao texto principal. Para melhor 

entender:  

- o número do capítulo está com 36 pontos 

tipográficos e a entrelinha em 45 (múltiplo de 15). 

Não importa se o tamanho da letra está em 36 

pontos. O importante é que a entrelinha é maior 

que 36 e múltipla de 45. 

- o título do capítulo está com 16 pontos e 

entrelinha 30 (também múltiplo de 15). Mas o que faz maior que 30 pontos a distância entre 

o título e o início do texto, deixando-o no centro ótico da página? A aplicação de mais pontos 

tipográficos, também em quantidade múltipla de 15, para abrir espaço em branco entre os 

dois elementos. 

 

Vamos então aos comandos do InDesign que realizam as mudanças tipográficas aqui implementadas, além 

de várias outras. Para mudanças na fonte, corpo, entrelinha e outras no texto é sempre necessário, 

em primeiro lugar, acionar a ferramenta TEXTO na Caixa de Ferramentas.  Com isso, abaixo da barra 

de menu automaticamente surgem no Painel de Controle (acionado através de WINDOW > CONTROL — Janela 

> Controle) um grupo de comandos para acionamento rápido, que muito facilitam a formatação do texto. 

 

 

O Painel de Controle tem seus comandos modificados de acordo com a ferramenta 
selecionada. Portanto, se é a ferramenta Seleção (SELECTION TOOL) que está 
selecionada, as opções serão outras. As informações que aparecem no Painel de Controle 
dependem do tipo de elemento do layout que está selecionado.  

 

 

É importante dizer que as alterações tipográficas só serão aplicadas se algum texto estiver 
selecionado. Para selecionar todo o texto do documento de uma vez só, basta clicar com a 
ferramenta Texto dentro do texto e em seguida escolher EDIT > SELECT ALL (Editar > 
Selecionar Tudo) ou CTRL+A. 
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Este painel tem 2 opções, a primeira para o Controle de Formatação de Caracteres e a segunda para 

Controle de Formatação de Parágrafos. 

 

 

PAINEL DE CONTROLE DE FORMATAÇÃO DE CARACTERES 
 

 

 

1. FONT (Fonte)      comando Type > Font 
; Com esta caixa é possível 

definir a fonte do texto que 

estiver selecionado no 

documento ou da caixa de texto 

aberta para digitação de um 

texto. 

; Para localizar a fonte mais 

rapidamente, sem a barra de 

rolagem, basta clicar as 

primeiras letras do nome da 

fonte. 

2. FONT STYLE (Estilo da fonte)  
; Quando uma fonte é escolhida, o InDesign apresenta a lista de estilos relativa àquela fonte: 

regular ou normal, bold (negrito), itálico, bold italic, condensada, condensada bold, 

condensada itálico, condensada bold itálico etc. As opções que surgem no menu variam de 

fonte para fonte. 

3. FONT SIZE (Corpo da fonte)      comando Type > Size 
; Tamanho da fonte em pontos tipográficos. O corpo pode variar de 0,1 a 1.296 pontos, com 

incrementos de 0,001 ponto. 
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4. LEADING (Entrelinha)      comando Type > Size 
; Entrelinha, espaço vertical entre as linhas 

de texto medida também em pontos 

tipográficos. A entrelinha é a medida que 

vai da base de uma linha de texto à base 

da linha de texto acima. A base de uma 

linha é a linha invisível sobre a qual 

muitas letras, sem descendentes 

(axinm), ficam. 

ais sutis no meio do texto. 

; Quando o corpo de um texto é 

selecionado, automaticamente a 

entrelinha é fixada em 120% do tamanho 

da letra. Por exemplo, se ao texto é 

aplicado o corpo 10, a entrelinha automaticamente é definida pelo InDesign em 12 pontos. 

Quando a auto-entrelinha está acionada, o valor da entrelinha aparece dentro de 

parênteses dentro da caixa no painel (12 pt). 

5. ALL CAPS (Caixa alta ou Maiúscula)      comando Type > Change Case > UPPERCASE 
; Passa para caixa alta o texto selecionado que esteja em letras minúsculas. 

 

O texto em caixa alta só será transformado em caixa baixa através do comando TYPE > 
CHANGE CASE > LOWERCASE (Tipo > Mudar Caixa > Caixa Baixa). Existem ainda duas 
outras opções: TITLE CASE passa um texto em caixa alta ou baixa para apenas as 
primeiras letras em caixa alta; SENTENCE CASE faz com que o mesmo texto tenha apenas 
a sua primeira letra em caixa ata. 

 

 

6. SMALL CAPS (Versalete) 
; Apenas as letras minúsculas do texto são transformadas em 

versalete. Estas têm o mesmo desenho da caixa alta e a altura da 

caixa baixa, ou seja, pelo padrão do InDesign, elas representam 

70% da altura da letra maiúscula. Para mudar este percentual, é 

preciso usar o comando EDIT > PREFERENCES > ADVANCED TYPE 

(Editar > Preferências > Tipo Avançado). Na janela aberta, há uma caixa com a opção 

SMALL CAP e o valor padrão de 70%. Versalete pode ser uma boa opção para a 

diagramação de números e siglas, pois assim ficam m
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Apenas para as fontes OpenType, o InDesign disponibiliza uma série de recursos que 
podem ser acionados através do Painel Character (WINDOW > TYPE & TABLES > 
CHARACTER — Janela > Tipo & Tabelas > Caractere ou CTRL+T). Quando a fonte não é 
OpenType, os comandos aparecem entre colchetes [ ]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. SUPERSCRIPT (Sobrescrito) 
; Eleva e reduz o tamanho do texto selecionado. Os valores de redução e 

elevação são percentuais do corpo e entrelinha da fonte e são baseados 

nas configurações das preferências de Tipo: EDIT > PREFERENCES > 

ADVANCED TYPE (Editar > Preferências > Tipo Avançado). Surgem então as caixas Size e 

Position na opção Superscript. 

8. SUBSCRIPT (Subrescrito) 
; Rebaixa e reduz o tamanho do texto selecionado. Os valores de redução 

e elevação são percentuais do corpo e entrelinha da fonte e são 

baseados nas configurações das preferências de Tipo: EDIT > 

PREFERENCES > ADVANCED TYPE (Editar > Preferências > Tipo Avançado). Surgem então 

as caixas Size e Position na opção Subscript. 

9. UNDERLINE (Sublinhado) 
; Sublinha o texto selecionado. O peso da linha do sublinhado depende do tamanho da fonte. 

10. STRIKETHROUG (Tachado) 
; Passa uma linha no meio do texto selecionado. O peso da linha do sublinhado depende do 

tamanho da fonte. 
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É possível personalizar a característica da linha 
do sublinhado ou do tachado usando, através 
do menu do Painel Character (WINDOW > 
TYPE & TABLES > CHARACTER — Janela > 
Tipo & Tabelas > Caractere ou CTRL+T), 
UNDERLINE OPTIONS ou STRIKETHROUGH 
OPTIONS. Na caixa que se abre é possível 
corrigir o desnível da linha que fica abaixo ou 
no meio do texto e ainda o estilo e cor dela. 

 

 

 

 

 
 
 
 
 
 
 
 
11. KERNING (in thousandths of an em) – Espaço entre um par de letras (em milésimos de  espaço m) 
; Kerning é o processo de adição ou subtração de espaço entre um 

par de letras. Basta colocar o cursor entre as letras ou selecionar 

o texto e aplicar uma das opções abaixo. O kerning pode ser 

aplicado automaticamente através do KERNING MÉTRICO ou do 

KERNING ÓTICO.  

; O KERNING MÉTRICO, o padrão do InDesign, usa pares de 

kerning incluídos em muitas fontes. Os pares de kerning contêm 

informações sobre o espaçamento de alguns pares específicos de 

letras. Alguns destes são: LA, P., To, Tr, Ta, Tu, Te, Ty, Wa, WA, We, 

Wo, Ya e Yo.  

; O KERNING ÓTICO ajusta o espaço entre os pares de letras 

baseado no design delas. Algumas fontes incluem robustas 

especificações de pares de letras. Porém, quando a fonte inclui somente o kerning mínimo 

embutido ou não tem nada, ou se o diagramador usa duas fontes ou tamanhos diferentes 

em uma ou mais palavras em uma linha, será preciso usar a opção KERNING OPTICAL 

(kerning ótico). 

; Para evitar a aplicação do kerning métrico, automaticamente embutido na fonte, basta 

escolher 0 (zero) na caixa de kerning. 

; O usuário tem ainda a possibilidade de definir o kerning manualmente, digitando o valor 

desejado na caixa de kerning. 

 

FALAR SOBRE ESPAÇO M 
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12. TRACKING (in thousandths of an em) – Espaço entre letras e palavras (em millésimos de  espaço m) 
; Tracking é o processo de adição ou 

subtração de espaço entre letras e 

palavras em um bloco de texto 

selecionado. Com valores negativos, 

o espaço entre letras e palavras será reduzido; com valores positivos, acontece o contrário. 

Deve ser usado com cuidado para que, ao apertar ou abrir demais o espaço entre letras e 

palavras, a leitura não seja dificultada. 

13. VERTICAL SCALE (Escala Vertical) 
; Possibilita a expansão vertical da fonte 

através de sua distorção. Fontes não 

expandidas têm valor de 100% para Escala 

Vertical.  

14. BASELINE SHIFT (Muda Linha Base) 
; Usa-se este recurso para mover um caractere selecionado 

acima ou abaixo da linha base do texto. É especialmente útil 

quando é preciso configurar manualmente frações. 

Diferentemente do sobrescrito e do subscrito, o texto elevado 

ou rebaixado não tem seu tamanho reduzido. 

15. HORIZONTAL SCALE (Escala Horizontal) 
; Possibilita a expansão horizontal da fonte 

através de sua distorção. Fontes não 

expandidas têm valor de 100% para Escala 

Horizontal.  

16. SKEW (FALSE ITALIC) — Inclinado (falso itálico) 
; Permite inclinar o texto selecionado a partir de um valor em 

ângulos. Valores positivos inclinam o texto para a direita, 

gerando um falso itálico. Valores negativos inclinam para a 

esquerda. 

17. CHARACTER STYLE (Estilo de caractere) 
; Exibe o estilo da letra ou do texto selecionado ou de onde esteja 

posicionado o cursor no texto. Caso seja exibida a informação [None] (Nenhum), a parte 

selecionada não está sendo submetida a nenhum estilo. Se houver estilos de caractere na 

caixa (criados através do painel Estilos de Caractere (WINDOW > TYPE & TABLES > 

CHARACTER STYLES), é possível aplicá-los ao texto selecionado. 
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18. LANGUAGE (Idioma) 
; Designa um idioma para o texto e, assim, determina qual ortografia e dicionário de 

hifenização (divisão silábica) será usado. Eis os passos para determinar um idioma, 

dependendo da situação:  

; Para designar o idioma apenas de um texto específico, selecione-o e, no painel, escolha o 

dicionário desejado. 

; Para mudar o idioma padrão do InDesign, de modo que este venha a valer para todos os 

novos documentos a serem criados, escolha o dicionário no painel com todos os 

documentos fechados. 

; Para mudar o dicionário padrão de um documento específico, abra-o e escolha EDIT > 

DESELECT ALL (Editar > Deselecionar Tudo). Somente então escolha o dicionário desejado 

no painel. 

 

 

PAINEL DE CONTROLE DE FORMATAÇÃO DE PARÁGRAFOS 
 

 

 

1., 2., 3., 4., 5., 6., 7. e 8. ALINHAMENTO DOS PARÁGRAFOS 
; Com estas opções é possível definir o alinhamento dos parágrafos através de oito formas 

diferentes: 1. ALIGN LEFT (Alinhado à esquerda); 2. ALIGN CENTER (Centralizado); 3. ALIGN 

RIGHT (Alinhado à direita); 4. ALIGN TOWARDS SPINE (Alinhado em direção à lombada); 5. 

JUSTIFY WITH LAST LINE ALIGNED LEFT (Justifica com a última linha alinhada à esquerda); 

6. JUSTIFY WITH LAST LINE ALIGNED CENTER (Justifica com a última linha centralizada); 7. 

JUSTIFY ALL LINE (Justifica todas as linhas ou justificação forçada); 8. ALIGN WAY FROM 

SPINE (Alinha além da lombada). É preciso que o texto esteja selecionado para que a opção 

de alinhamento funcione. No caso das opções 4 e 8, é preciso que o texto esteja distribuída 

em páginas espelhadas. 
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9., 10., 11. e 12. INDENTAÇÃO 
; Para aplicar indentação a um parágrafo ou mais parágrafos, basta selecioná-los e aplicar a 

opção pretendida. Podem ser usados valores de indentação em quaisquer das unidades 

disponibilizadas pelo InDesign, como centímetros, pontos, paicas, polegadas (inches) etc.  

; A indentação é um bom recurso para aplicar em textos que tenham citações deslocadas 

mais à direita em relação ao fluxo normal do texto. Usa-se, neste caso, a opção 9 (LEFT 

INDENT). 
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13. e 14. ESPAÇO ANTES E DEPOIS DO PARÁGRAFO 
; É possível controlar o espaço acima e abaixo dos parágrafos. Se um parágrafo começa no 

topo de uma coluna ou quadro, o InDesign não insere espaço acima dele. Somente a partir 

do segundo. Na diagramação orientada por uma grade, os espaços acima e abaixo dos 

parágrafos devem, quando somadas à entrelinha do fluxo normal do texto, totalizar um 

número múltiplo da entrelinha. 
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15. e 16.  CAPITULAR (COM UM OU MAIS CARACTERES) 
; Capitulares podem ser adicionadas a um ou mais parágrafos. A linha de base da capitular 

fica situada uma ou mais linhas abaixo da linha de base da primeira linha do parágrafo.  

; Para criar uma capitular, clique no parágrafo onde quer aplicar o efeito e na caixa DROP 

CAP NUMBER OF LINES (Número de Linhas da Capitular) indique o número de linhas para a 

altura da letra em destaque.  

; Para aumentar o número de letras transformadas em capitulares, digitar o valor na caixa 

DROP CAP ONE OR MORE CHARACTERES (Capitular com um ou mais caracteres).  

; Caso o parágrafo tenha indentação na primeira linha, digite 0 (zero) na respectiva caixa 

para que a capitular fique alinhada com o restante do texto. 
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